PAGE  
162

Глава 7 
Цифровой модулятор (/4-DQPSK
В предыдущей главе рассматривался аналоговый модулятор (/4 -DQPSK, работающий во временной области. В данной главе используется цифровой модулятор с относительной квадратурной фазовой манипуляцией с фазовым сдвигом на (/4. Для этого рассматриваются следующие задачи:

Преобразование модулятора (/4 -DQPSK в проект DSP, основанный на цифровой обработке данных.

Выполнение подстройки схемы DSP.

Расчет характеристики EVM для оценки качества системы.

Проектирование и синтез цифрового фильтра FIR для замены им фильтра с характеристикой в виде приподнятого косинуса.

7.1. Обработка цифровых данных

7.1.1. Формирование цифрового источника данных

Откроем проект CommSys_Lab8_prj и выполним перевод времязависимого модулятора (/4 -DQPSK (из предыдущей главы) в проект цифрового проектирования DSP. Для этого:

Откроем проект “a_PI4DQPSK_Sys”. Затем сохраним этот проект командой File> Save As... и обозначим его как “b_PI4DQPSK_Sys_Numeric”.

Удалим из системы источник Data и элемент SymbolSplitter.

Дезактивируем оставшуюся часть системы (все компоненты, справа от цифрового модулятора EncoderIQ, включая сам модулятор).

Вместо источника Data  внесем источник Bits из библиотеки «Numeric Sources».

Поместим элемент LogicToNRZ из библиотеки «Signal Converters» и присоединим его к выходу источника данных Bits. Этим задается перевод изменение логического сигнала между 0/1 источника данных Bits (между 1 и 0) к уровням +/-1 V сигнала NRZ (невозвращаемым к нулю).

Элемент Distributor2 из библиотеки «Numeric Control» соединим  к выходу преобразователя «LogicToNRZ» (рис. 7.1). Этот элемент имеет то же самое функциональное назначение, что и элемент SymbolSplitter, работающий во временной области. Элемент Distributor2 будет принимать две выборки и передавать первую выборку на верхний вывод, а вторую выборку на нижний вывод, действуя подобно последовательно-параллельному конвертору для формирования символов I и Q из последовательности битов на входе.
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Рис. 7.1. Преобразование потока данных в вид последовательно-параллельных данных

Подключим элемент TkPlot к верхнему выводу Distributor2 (рис. 7.2). Установим следующие параметры элемента TkPlot:

Label = Q symbols
Geometry = 500x400+0+0

xTitle = Samples

yTitle = Amplitude

XRange = 0 20

Persistence = 20


[image: image2.png]e T )

Bits LogicTaNRZ Distriautar?
B1 L3 D3 Q symbol®
Type=Random Amplitude=1.0 BlockSize=1

Samples”
yTile="Ampliude’
xRange="0 20"
yRange="-15 15"
Style=connect

ProbOfZero=05
LFSR_Length=12
LFSR_InitState=1





Рис. 7.2. Включение окна интерактивного просмотра на выход

Выполним моделирование и просмотрим результаты расчета (рис. 7.3).
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Рис. 7.3. Временная зависимость потока Q символов

Битовые данные на рис. 7.3 не являются прямоугольными, какими были данные при использовании времязависимых элементов. Это происходит потому, что в цифровых расчетах выполняется только одна выборка на символ, что является приемлемым для нефильтрованных символов, где амплитуда равна или +1V или -1V без вибраций и наложений.

Когда амплитуда символа сохраняется постоянной, выполнение нескольких выборок на символ не добавляет никакой дополнительной информации. Однако дело обстоит не так, когда символы были искажены фильтрами.

7.1.2. Кодирование (цифровое модулирование) данных

Удалим выходную компоненту TkPlot и активируем (снимая перекрестия операцией Re-activate) оставшуюся часть системы.

Внесем два элемента FloatToTimed из библиотеки «Signal Converters».

Присоединим их к выходам элемента Distributor2. Установим следующие параметры:

TStep = Sym_time – единицы устанавливаются на None
Численные элементы работают с числами, значениями в выборках, и не используют никакого временного шага (timestep) связанного с ними.

Элементы FloatToTimed добавляются, чтобы выполнить расстановку по времени цифровых значений выборок.  Параметр TStep установлен равным Sym_time, потому что каждая выборка представляет символ в одном символьном временном интервале. Присоединим выходы элементов FloatToTimed ко входам «EncoderIQ».

      В библиотеке численных элементов «Numeric» не имеется встроенного кодера (цифрового модулятора) (/4 -DQPSK, хотя можно использовать имеющиеся базовые элементы. Поэтому мы будет использовать времязависимый модулятор, а затем временной сигнал будет конвертироваться назад в цифру с плавающей запятой, используя элемент TimedToFloat.

Поместим два элемента TimedToFloat из библиотеки Signal Converters и присоединим их к выходам EncoderIQ (рис. 7.4).
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Рис.7.4. Включение времязависимой компоненты модулятора Encoder в цепочку цифрового моделирования

Внесем два фильтра RaisedCosine из библиотеки «Numeric Communications» со следующими параметрами:

Interpolation = 10

Length = 161

SymbolInterval = 10

ExcessBW = 0.35

SquareRoot = Yes.

Присоединим к выходу элементов TimedToFloat  фильтры (рис. 7.6) и удалим операцией Delete стоявшие ранее времязависимые фильтры.

Также поместим две численных компоненты «Gain» из библиотеки «Numeric Math»  и присоединим их к выходам фильтров  «RaisedCosine».     Параметр усиления установим равным 

Gain = 1

Выберем два элемента преобразования данных FloatToTimed из библиотеки «Signal Converters» и присоединим их к выходу элементов Gain. Установим параметр

TStep = Tstep  (единицы None).
Выходы элементов FloatToTimed присоединим ко входам I и Q  «QAM_Mod».

Установки фильтра FIR с частотной характеристикой
 типа приподнятого косинуса:

Interpolation (Интерполяция): Поскольку фильтрация Найквиста теперь выполняется в базовой полосе частот немодулированных сигналов, необходимо иметь несколько выборок на символ, поскольку амплитуды символа больше не будут постоянные.  Параметр Tstep, используемый во времязависимом модуляторе PI4DQPSK был установлен для выполнения 10 выборок/символ, поэтому коэффициент интерполяции для этого фильтра установим равным 10. Это  эквивалентно увеличению выборок вверх сигнала на 10 на входе фильтра (что выполняет элемент UpSampling).

Length (Длина): Этот фильтр - по существу FIR фильтр, с заданным числом звеньев (равным количеству суммируемых на выходе импульсных характеристик). Нечетное число звеньев приводит к симметричной импульсной характеристике для линейной фазы, с одним коэффициентом звена, лежащим в центре импульса (рис. 7.5). Таким образом, 80 звеньев лежат справа от центра и 80 - слева от центра фильтра с длиной 161 звена, как показано ниже. Задержка через фильтр – это расстояние от t=0 до центра импульса (в этом примере t=0.329 mS).
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Рис. 7. 5. Временная зависимость импульса на выходе фильтра

SymbolInterval (символьный интервал): Этот параметр определяет, сколько выборок выполняется в символе. В данном примере выполняется 10 выборок/символ. Есть 8 символьная задержка (80 реакций разделенные на 10 выборок/символ, где каждое звено представляет задержку в 1 выборку) в этом примере, поскольку здесь имеется 80 реакций между t=0 и центром импульсной характеристики. Это эквивалентно тому, что задержка 8*Sym_time, используемая во время-зависимом фильтре с приподнятом косинусом, равна 0.329 mS. Следовательно, этот фильтр эквивалентен время-зависимому фильтру с приподнятым косинусом.

Выполним моделирование схемы рис. 7.6 (набор данных должен значение по умолчанию к «b_PI4DQPSK_Sys_Numeric») и выведем результаты расчета.
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Рис. 7.6. Полная схема приемника импульсного потока данных

7.1.3. Просмотр сигнала Iout во временной области

Поток демодулированных символов I, «Iout», показывается на рис. 7.7. Обратим внимание на задержку через систему и рассчитаем величину времени, требуемого для осуществления выборки в середине первого символа вне системы.
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Рис. 7.7. Временной процесс сигнала Iout
Реальная часть потока данных на выходе демодулятора pi/4 DQPSK показывается на рис. 7.8.
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Рис. 7.8. Начальная область импульса и маркер m1, передвигая который можно видеть, какой номер выборки соответствует данному времени

Замечание о времени символа (symbol time)

Из рис. 7.8 видно, что момент старта, в терминах задержки символьного времени, равен 17. Эта задержка происходит из-за 8- символьного времени запаздывания через время-зависимый фильтр с приподнятым косинусом внутри демодулятора, плюс дополнительная задержка через FIR фильтр.


Фактическое начальное время для расчета сигнального созвездия IQ должно быть установлено равным 19*Sym_time для того, чтобы время, равное двум дополнительным символам, осталось для дифференциального кодирования.


       Обратим внимание, что амплитуда символов не равна ( 1 V. Коэффициент усиления усилительных блоков G2 и G3 будет настроен так, что символы (Iout и Qout) имеют амплитуды (1 V. Чтобы сделать процесс подстройки легче, сначала построим сигнальное созвездие.

7.1.4. Сигнальное созвездие

Сигнальное созвездие – это график, который чертится в системе переменной Const, рассчитанной с помощью встроенной функции constellation (рис. 7.9 справа).
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Рис. 7.9. Временной процесс и сигнальное созвездие, рассчитанное с помощью встроенной функции constellation
Амплитуда символов на рис. 7.9 равна 0,4 Вольт.

Сохраним эти данные под именем «b_PI4DQPSK_Sys_Numeric».

7.2. Подстройка схем DSP
7.2.1. Подготовка к подстройке амплитуды символа 
к величине +/-1 V
Кликнем на иконку Tune[image: image11.png]


 в схематическом окне. Это откроет окно «Tune Control», которое используется для установки параметров  подстройки и диапазона изменения каждого параметра.
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Рис. 7.10. Диалог выбора режима подстройки

После появления диалога рис. 7.10, сдвинем курсор на схему и заметим пересечение. 

Выберем этим перекрестием надписи усиления одного из двух усилительных элементов (G2 and G3) для реализации процедуры подстройки.

В окне «Tune Control» (рис. 7.10):

- кликните на кнопку «Details»;

- выберите опцию «After Pressing Tune» для того, чтобы моделирование запускалось после каждого изменения схемы.

Должно появиться окно «Tune Control», как показано на рис. 7.11.

В этом окне пользователь может изменять величины Min/Max, номинальные величины и размер шага отдельно для каждого параметра, который нужно подстраивать. Можно выбрать и линейную Lin, и логарифмическую зависимость Log изменения параметров.
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Рис. 7.11. Диалог подстройки коэффициентов усиления усилителей

7.2.2. Процесс подстройки

Измените величину G2 = 1.4 и затем нажмите кнопку «Tune». Рассмотрите сигнальное созвездие в окне DDS.

Измените величину G3 = 1.6 , и нажмите на «Tune». При этом на сигнальном созвездии отражается это изменение.

Выполним несколько перестроек и заметим, как влияет на сигнальное созвездие разбаланс сдвигов I и Q (рис. 7.12).
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Рис. 7.12. Сигнальное созвездие при различных усилениях
 в плечах I и Q
Подстраивая ползунки в диалоге Tune (рис. 7.11), найдем величины G2 и G3, которые обеспечивают амплитуды символов, равные 1. Полученные в результате подстройки величины должны быть G2=G3=1.6.

Нажимая «Reset» в окне «Tune Control», установим G2 и G3 к их исходным значениям 1. Затем нажмите «Cancel» и «Yes» для исключения потери информации установки. На этом прекращается процесс подстройки и схема остается с начальными параметрами.

7.2.3. Настройка переменных

Для обеспечения баланса усиления при подстройке, выполним следующие шаги:

Отредактируем блок переменных (рис. 7.13). Добавим переменную Gain_value = 1.
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Рис. 7.13. Параметры блока переменных VAR
Отредактируем блоки G2 и G3: Установим их параметры (рис. 7.14):

Gain = Gain_value
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Рис. 7.14. .Два блока усиления

Запустим процесс подстройки нажатием на иконку «Tune» [image: image17.png]


.

В появившемся окне «Tune Control» , изменим опцию «Simulate» на «After pressing Tune».

Выберем переменную «Gain_value», в блоке переменных, для ее подстройки.

В окне «Tune Control», отметим начальные значения 1 для «Gain_value» и нажмем “Tune”. Этим будет маркироваться начальная точка в сигнальном созвездии в окне DDS.

Увеличим величину «Gain_value», пошагово на 0.1, до 1.6. Сигнальное созвездие будет изменяться и прочерчивать трассы, показанные на рис. 7.15.
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Рис. 7.15. Изменение сигнального созвездия при изменении величины усиления

В окне «Tune Control», нажмем кнопку «Update». Это будет подставлять значения в  схему во время процесса подстройки.

Сохраним схему под именем «b_PI4DQPSK_Sys_Numeric».

7.3. Характеристика ошибки вектора
 Error Vector Measurement
Внесем компоненту расчета характеристики «ErrVecMeas» (EVM) из библиотеки  «Obsolete Sinks» и присоединим её к выходу схемы «new_DQPSK_Pi4Demod» (табл. 7.1) .

Установим следующие параметры (все параметры поясняются в табл. 7.2)

Start = 19*Sym_time 
 (единицы установите на  None)

Stop = Tstop 

  (единицы установите на None)

SymbolTime = Sym_time

Здесь должна быть использована фундаментальная единица (секунда).

Measurement_Type = ERROR_VECTOR_MAGNITUDE

Symbol _Burst_Length = 64

Modulation_Type = PI4_DQPSK_MOD
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Рис. 7.16. Включение компоненты EVM
Выполним моделирование цифровой схемы и выведем результат расчета EVM в таблицу. Величина RSS есть модуль и фаза ошибка каждого рассчитанного символа. 
    Величина, показанная здесь – ошибка 0.4 %:
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Сохраним окно DDS под именем “b_PI4DQPSK_Sys_Numeric” и закроем его.

Самый большой вклад в ошибку вносит точность моделирования фильтров с приподнятым косинусом. Отключение этого фильтра и пропускание сигнал напрямую используется для оценки ошибки моделирования и подтверждения этого. Значение задержки для времязависимых фильтров (или числа звеньев числового фильтра) имеют прямую связь с точностью моделирования фильтра.

Табл. 7. 1.Параметры демодулятора new_DQPSK_PI4Demod
	D 2


	Величина
	Пояснение параметра

	RIn
	50.0 Ohm
	Входное сопротивление

	ROut
	50.0 Ohm
	Выходное сопротивление

	RTemp
	- 273.15
	Температура

	Ref Freq
	IF_freq
	Несущая частота

	Symbol Time
	Sym _ time
	Длительность символа

	Excess Bw
	0.35
	Эффективная ширина полосы


Табл. 7.2. Параметры компоненты расчета ошибки вектора Err Vec Meas  

	E 2


	
	Имя измерителя ошибки вектора

	Start
	19 * Sym_time
	Время запуска символа

	Stop
	Tstop
	Время окончания символа

	Time Unit
	sec
	Единицы времени

	Symbol Time
	Sym_time
	Длительность символа

	Measurement _ Type
	ERROR_VECTOR_MAGNIT UDE
	Ошибка модуля вектора

	Symbol_Burst_Length
	64


	Длина символа

	Modulation_Type
	PI4_DQPSK_MOD

	Тип модуляции


Большая задержка во времязависимых фильтрах эквивалентна увеличению числа звеньев цифрового фильтра, в результате чего увеличивается точность фильтра. 

Величина E2 = 0.4% – это хорошее значение для приближения к идеальной системе, поскольку в этом случае ошибка системы более чем десять раз лучше чем в случает расчета ошибки, равной 12.5%. 
    Ошибка, вносимая фильтрами, должна быть незначительной при вкладе в ухудшение характеристик системы, представленных в окончательном проект.

7.4. Синтез цифрового FIR фильтра
7.4.1. Утилита синтеза цифрового фильтра

      Выполним синтез цифрового фильтра FIR имеющего частотную характеристику в виде приподнятого косинуса.

      Запустим утилиту Filter Synthesis Tool, закрыв перед этим все открытые окна Data Display. Для этого запустим команду  Tools > DSP Filter > Start DSP Filter.

В появившемся окне (рис. 7.17) установим следующие параметры:

Filter Type = FIR

Response Type = Root Raised Cosine

Design Method = Windowing_Rectangular

Auto Order = de-activated

Order Number = 160 (для синтеза фильтра с 161 taps: # of taps=order+1)

Frequency Unit = kHz

Sampling Frequency = 243 kHz (10*symbol rate для корреляции с коэффициентом  up-sampling = 10 (используемом со встроенным цифровым фильтром)
Symbol Rate = 24.3e3

Roll Off = 0.35.
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Рис. 7. 17. Утилита синтеза цифрового фильтра

Нажмем на кнопку старта синтеза фильтра [image: image22.png]



      Установим характеристики фильтра в окне DDS. Частота отсечки фильтра должна быть приблизительно 12.15 кГц, или 1/2*Sym_time (это приблизительно, потому что самый подходящий коэффициент расширения полосы равен 0.35).
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Рис. 7. 18. Частотная и импульсные характеристики цифрового фильтра

       Поместим маркер в пик импульсной характеристики и заметим, что он соответствует времени 8*Sym_time, или 329.2 uS. Это значение задержки эквивалентно задержке, которая задавалась для времязависимого фильтра в главе 6. 

     Увеличение этой задержки для времязависимых фильтров с характеристикой приподнятого косинуса дает в результате сдвиг вправо в импульсной характеристике, что связано с увеличением числа звеньев (taps) в цифровом фильтре. Эти характеристики фильтра улучшаются с увеличением задержки во временном фильтре и улучшается с увеличением звеньев в цифровом фильтре.

     Кликнем File> Save As… для сохранения проекта под именем «dfilter_PI4DQPSK».

      Заметим, что файл проекта сохраняется в поддиректории «synthesis» проекта. Это делает различие между файлами проекта ADS и файлами утилиты проектирования и синтеза цифрового фильтра.

7.4.2. Создание схемы синтезированного фильтра  

Проектный файл «DSP Filter Designer» может быть использован для генерирования проектного файла  ADS, который может быть промоделирован на ADS.

Выберем в окне утилиты синтеза цифровых фильтров рис. 7.17 команду Design > Generate Schematic…  чтобы автоматически сгенерировать схему. Впечатаем имя: «c_Synthesized_Filter» (рис. 7.19).
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Рис. 7.19. Окно генерации схемы цифрового фильтра

В окне Schematic, сохраним схему фильтра. После этого утилиту синтеза цифровых фильтров DSP Filter Synthesis можно закрыть.

7.4.3. Моделирование с новым синтезированным фильтром

В окне ADS снова откроем проект «b_PI4DQPSK_Sys_Numeric».

Командой File> Save As… сохраним его под именем «d_PI4DQPSK_Sys_New».

Удалим два фильтра RaisedCosine.

Внесем два элемента UpSample из библиотеки «Numeric Control» и соединим их с выходом конвертеров TimedToFloat. Установим параметр Factor = 10. Он имеет такое же назначение, как и коэффициент интерполяции в фильтре RaisedCosine.

Загрузим проект нового фильтра, «c_Synthesized Filter», из библиотеки DSP Subnetworks Library Design, и соединим его к выходу каждого элемента “UpSample”.

Соединим элементы Gain к выходам фильтров и установим параметры:
Gain = 5

Установим усиление каждого усилительного блока равным 5 (или переменную Gain_value = 5 в блоке «Var»). Эта установка усиления нормализует I и Q к величине (1V. Значение 5 было определено экспериментально, регулируя его, пока амплитуды символа не (1 V.

Выполним моделирование и снова откроем окно вывода данных «b_PI4DQPSK_Sys_Numeric.dds».

Установим активным «d_PI4DQPSK_Sys_New» и проверим результаты.

Эти результаты должны быть аналогичны результатам, полученным на встроенном численном фильтре с приподнятым косинусом.

Результаты должны выглядеть подобно рис. 7.20.
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Рис. 7. 20. Результаты расчета сигнального созвездия

Коэффициенты звеньев фильтра - это числа с плавающей запятой для этого примера. Они должны быть  получены в результате синтеза как числа в фиксированной запятой для моделирования ошибки усечения.

7.5. Описание компоненты ErrVecMeas
[image: image26.png]Evi




Компонента EVM (Error Vector Magnitude Measurement – ошибка величины вектора сигнала) служит для оценки искажений сложного широкополосного сигнала и несколько раз используется в данной главе. Для справки приведем параметры этой компоненты.  

Табл. 7.3. Пояснение параметров компоненты EVM
	Имя
	Описание
	По умолчанию
	Единицы
	Тип сигнала

	Plot
	Если моделирование установлено с открытым выводом данных после моделирования и если Plot не установлен на 'None', то данные заносятся в сборник данных sink: None, Rectangular 
	None
	 
	нечисленный

	Start
	Начальное время для записи данных. DefaultTimeStart будет приниматься из контроллера DF. 
	DefaultTimeStart
	time
	С плавающей запятой

	Stop
	Конечное время записи данных. DefaultTimeStop будет взято из контролера DF. 
	DefaultTimeStop
	time
	С плавающей запятой

	SymbolTime
	Время длительности символа 
	1.0
	time
	С плавающей запятой

	Measurement_Type
	Опции для типа расчета в EVM: ERROR_VECTOR_MAGNITUDE, C0_DC_OFFSET, C1_PHASE_AND_POWER, W_FREQ_OFFSET_AND_GAIN_RATE, MAGNITUDE_BURST_ERROR, PHASE_BURST_ERROR, SAMPLED_TEST_DATA_SIGNAL 
	ERROR_VECTOR_
MAGNITUDE
	 
	нечисленный

	Symbol_Burst_Length
	Число символов в burst для расчета EVM 
	16
	 
	целочисленный

	Modulation_Type
	Опции для типа модуляции входного сигнала: BPSK_MOD, PSK8_MOD, PI4_DQPSK_MOD, QPSK_MOD, QAM16_MOD, QAM64_MOD, PAM4_MOD, PAM8_MOD 
	PI4_DQPSK_MOD
	 
	нечисленный


Диапазон параметров компоненты EVM
Start: 0[image: image27.png]


Start[image: image28.png]


Stop
SymbolTime: 0 < SymbolTime
Symbol_Burst_Length: 1[image: image29.png]


Symbol_Burst_Length 

Сигналы на входе
	Вывод
	Имя
	Описание
	Тип сигнала

	1
	input
	Временной сборник входного сигнала 
	времязависимый

	2
	inputQ
	Входная фаза Q  
	времязависимый


1. Характеристика Error vector magnitude используется для оценки точности моделирования модуляторов. Она используется, например, в системе цифровой сотовой связи IS-54 TDMA для установки минимальных требования для точности модулирования модуляторов [image: image30.png]


/4-DQPSK. 

Для задания уравнений для расчета EVM используются следующие определения стандарта EIA/TIA IS-54-B TDMA Cellular System Dual-Mode Mobile Station-Base Station Compatibility Standard (Error Vector Magnitude Requirement). 
    Пусть Z(k) обозначает действительные комплексные векторы (I и Q), произведенные для получения реальной передачи идеального приемного фильтра при заданном k, а импульс в течение одного периода S(k) определен как идеальный опорный символ (нормализованный так, что его максимальная энергия попадает на единичную окружность, рис. 7.21). Тогда Z(k) моделируется как 
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где 


W = e Dr+jDa учитывает и смещение частоты (вращение фазы в [image: image32.png]


a радиан/символ) и изменение амплитуды (в [image: image33.png]


r непер/символ), 

C0  - комплексная начальная постоянная, представляющая разбаланс квадратурного модулятора,

C1 – комплексная постоянная, представляющая произвольную фазу и выходную мощность передатчика,  

E (k) - остаточная векторная ошибка  для выборок S(k). 
Корень квадратный из векторов ошибки равен 
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где C0, C1, W выбираются для минимизации верхнего выражения и затем используются для расчета отдельных ошибок вектора E(k) на каждом символе. 

EVM (rms) определяется как корень квадратный от суммы квадратов ошибок векторов, определенных выше. Таким образом, EVM рассчитывается по формуле:

[image: image35.png]EVM(rms) =
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где MIN и MAX это индексы целых чисел первого и последнего символов в пачке символов, для которых рассчитывается EVM. При установке параметра Start (табл. 7.3)  в расчете EVM можно выбрать, с какого символа начинается расчет (так определяется MIN). При установке Symbol_Burst_Length в расчете EVM можно выбрать длину символа в сумме (отметим, что Symbol_Burst_Length=MAX-MIN+1). 

Пользователь может установить параметр Start для расчета EVM для выборки сигнала при оптимальной фазе символьного времени.
     Подходящая величина для Start может быть определена при рассмотрении глазковой диаграммы. 

1. Опции Measurement_Type для Error Vector Magnitude (rms), C0 (DC offset), C1 (Output power and Phase (deg)), W (amplitude change (непер/символ), и сдвиг фазы (радиан/символ) выбираются на основании замечания 1. Эти величины затем показываются в окне  при расчете EVM. 

        Опции Measurement_Type для суммы отклонений модулей, или суммы погрешности фазы (в градусах) относятся к погрешностям модулей или фазы отдельных полученных символов. Выбранное значение для пакета ошибок модулей или фаз дает характеристику EVM, отображающую ошибки модуля или фазы для всех символов в сумме. Рис. 7.22 показывает, как определяются ошибки модуля и фазы. 
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Рис. 7.21. Ошибка по модулю и фазе 

1. Сигнальное созвездие IQ (рис. 7.22) определяется опцией Measurement_Type и масштабируется так, что точки IQ лежат на единичной окружности. Например, для сигнального созвездия все четыре точки IQ лежат на единичной окружности. 

Для фазоманипулированного сигнала (включая BPSK, 4-PAM, 8-PAM) канал Q сигнала устанавливается на 0.0, а точка максимальной энергии IQ должна быть равна величине 1.0. 

 
Рис. 7. 23 показывает несколько таких примеров сигнальных созвездий IQ, использующих расчет EVM.
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Рис. 7.23. Примеры сигнальных созвездий IQ при использовании в расчете параметра EVM
Итак, в этой главе, модулятор во временной области был перепроектирован как цифровой модулятор DSP и показана возможность объединить проекты DSP с аналоговой радиосистемой в одном проекте. 


Проект DSP использует компоненты, в которых выполняется численный расчет, и которые обрабатывают численные выборки и не используют понятия времени. Время отсчетов добавлялось к выборкам в тех случаях, когда должны были использоваться времязависимые элементы, например, дифференциальный модулятор (/4 -DQPSK.

Чтобы откорректировать амплитуды символа к  +/-1 V, использовалась процедура настройки. Показаны различные возможности подстройки.

Характеристики EVM были рассчитаны, чтобы установить общую количественную оценку работы системы. 
     Работа идеальной системы была выровнена по критерию минимальной ошибки обработки потока данных.

Был исследован цифровой фильтр с характеристикой типа приподнятого косинуса (RaisedCosine) и после этого заменен фильтром, который был разработан и синтезирован, используя встроенную утилиту синтеза фильтров Digital Filter Designer. 
      Расчеты с плавающей запятой в этом фильтре дали результаты, аналогичные результатам со встроенным фильтром RaisedCosine. 

       Корреляция между задержкой, указанной во времязависимом фильтре с приподнятом косинусом и количеством сигналов (звеньев), указанных для фильтра FIR была выровнена, устанавливая задержку сигналов, которая непосредственно связана с характеристикой фильтра.
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